Chapter 1

Project Management: What Is I,
and Why Should You Care?

In This Chapter

Discovering how traditional project management makes the move to software
Understanding what elements of a project are managed in Project
Understanding the project manager’s role

Exploring the role of the Internet in project management

Getting started using Project Guide

Using a template to start a new project

Saving a project file

Finding help in Project

Welcome to the world of computerized project management with
Microsoft Project. If you’ve never used project management software,

you're entering a brave, new world. It’s like walking from the office of 25 years
ago — with no fax, voicemail, or e-mail — into the office of today with its
wealth of high-tech devices.

Everything you used to do with handwritten to-do lists, word processors, and
spreadsheets all magically comes together in Project. However, this transi-
tion won’t come in a moment, and you need a basic understanding of what
project management software can do to get you up to speed. If you've used
previous versions of Project, this little overview can help you refresh your
memory as well as ease you into a few of the new features of Project 2007.

So, even if you're a seasoned project manager, take a minute to review this chap-
ter. It provides the foundation for how you’ll work with Project from here on.
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The ABCs of Project Management

You probably handle projects day in and day out. Some are obvious, because
your boss named them so that any fool would know that they’re projects: the
Acme Drilling Project or the Network Expansion IT Project, for example.
Others are less obvious, such as that speech thing you have to do on
Saturday for your professional association or washing the dog.

If you need to organize a company holiday party, it’s a project. If you were
handed a three-year Earth-exploration initiative to find oil in lowa, coordinate
subcontractors and government permits, and work with a team of 300 people,
that’s definitely a project. Yes, even that speech you have to present is a
project because it has certain characteristics.

Understanding what your projects, large or small, have in common is the
basis of understanding what Project can do for you. All projects have

v An overall goal

v A project manager

v Individual tasks to be performed

v+ Timing for those tasks to be completed (such as three hours, three days,
or three months)

v Timing relationships between those tasks (For example, you can’t put a
new manufacturing process in place until you train people in how to use
the process.)

v Resources (people, equipment, facilities, and supplies, for example) to
accomplish the work

v A budget (the costs associated with those people, equipment, facilities,
and supplies)

Project management is simply the process of managing all the elements of a
project, whether that project is large or small.

The three Ts: Tasks, timing, and
dependencies (well, two Ts and a D)

As Lewis Carroll said, “If you don’t know where you’re going, any road will get
you there.” So, first things first: You have to understand the goal of your project
so you can begin to build the tasks that have to be performed to get you there.



Chapter 1: Project Management: What Is It, and Why Should You Care?

|
Figure 1-1:
You'll
probably
spend most
of your time
in Projectin
outline-like
Gantt Chart
view.
|

A task is simply one of those items you used to scribble on your handwritten
to-do lists, such as Write final report or Apply for permits. Tasks are typically
organized into phases (appropriate stages) in Project, arranged in an outline-
like structure, as you can see in the project shown in Figure 1-1. Because timing
is essential in any project, Project helps you set up and view the timing rela-
tionships among tasks.

Becoming a task master

A task can be as broad or as detailed as you like. For example, you can create
a single task to research your competition, or you can create a project phase
that consists of a summary task and subtasks below it. For example, the sum-
mary task might be Competitive Research, with the subtasks Researching
Online Business Databases, Assembling Company Annual Reports, and
Reviewing Competitive Product Lines.

Adding tasks to a Project file doesn’t cost you a thing (except a nanobit of
memory), so a project can have as many tasks and as many phases as you
like. You simply use the outlining structure in Project to indent various levels
of tasks. The more deeply indented in an outline a task is, the more detailed
the task.
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One handy thing about this outlining structure is that you can roll up all the
timing and cost data from the subtasks within your phases into summary-
level tasks. Three sequential subtasks that take a day each to complete and
cost you $200 apiece result in a summary task that spans three days and
costs $600. You can view your project at various levels of detail or get auto-
matic tallies of timing and costs if you prefer to simply view the summary
level of tasks.

For more about defining and creating tasks, check out Chapter 4.

All in the timing

They say that timing is everything: Rome wasn’t built in a day, a stitch in time
saves nine, and don’t even ask me about choosing exactly when to sell your
high-tech stocks. The importance of timing applies to Project tasks, too.
Almost all tasks have timing — referred to as duration — which is the amount
of time needed to complete the task.

The only tasks without duration are milestones. A milestone is a task of zero
duration; in essence, it simply marks a moment in time that must be reflected
in your Project outline. Typical milestones are the approval of a brochure
design and an assembly line startup.

Project doesn’t provide magic formulas for duration: You assign duration
based on your own experience and judgment. Does designing a product pack-
age take three days or three weeks? Will obtaining a building permit happen
in a day or a month? (Remember that you’re dealing with city hall, so think
before you answer!) Project isn’t an oracle: You have to provide facts, figures,
and educated guesses to build your Project schedule. After that information
is entered, though, Project can do some wonderful things to help you main-
tain your schedule and monitor your progress.

Task co-dependencies

The final piece in the puzzle of how long your project will take is the concept

of dependencies, or the timing relationships among tasks. If you have a sched-
ule that includes ten tasks that all begin at the same time, your entire project

will take as long as the longest task (see Figure 1-2).

After you define and implement timing relationships among tasks, your
schedule can stretch over time like a long rubber band. For example, one task
might begin only after another is finished. Another task can start halfway
through the preceding task. The second task cannot start until a week after
the first task is finished. Only after you start to assign these relationships can
you begin to see a project’s timing as related to not just each task’s duration
but also the specific ways in which the tasks relate to each other.
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Here are some examples of dependencies:

»* You can’t begin to use a new piece of equipment until you install it.

»* You must wait for a freshly poured concrete foundation to dry before
you can begin to build on it.

» You can'’t start to ship a new drug product until the FDA approves it.

Figure 1-3 shows a project plan where each task’s duration and the dependen-
cies among tasks have been established, and the resulting overall timing of
the project.

One other brief note about the timing of tasks: In addition to applying depen-
dencies to tasks, you can apply constraints. For example, say that you don’t
want to start shipping your new cake flavor until you get the ad for it in your
Christmas catalog, so you set a dependency between those two events. You
can also set a constraint which says that you must start producing the cakes
no later than November 3. In this case, if you don’t make the catalog deadline,
the product will still ship on November 3; that task will not be allowed to slip
its constraint because of this dependency relationship.
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You can find out more about constraints in Chapter 4 and about the fine art
of managing dependencies in Chapter 6.

Lining up your resources

When people first use Project, some get a bit confused about resources.
Resources aren’t just people: A resource can be a piece of equipment you
rent, a meeting room that you have to pay an hourly fee to use, or a box of
nails or a software program you have to buy.

Project allows for three kinds of resources: work resources, material
resources, and cost resources. A work resource is charged by how many
hours or days the resource (often human) works on a task. A material
resource, such as sewing supplies or steel, is charged by a per-use cost or by
a unit of measurement (such as square yards or linear feet or tons). A cost
resource has a set cost, such as a conference fee of $250; this cost doesn’t
vary by how much time you spend at the conference or how many people
attend.

Some resources, such as people, perform their work according to a working
calendar. If a person works an 8-hour day and you assign him to a task that
takes 24 hours to complete, that person has to put in three workdays to
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complete the task. In comparison, someone with a 12-hour workday takes
only two days to complete the same task. In addition, you can set working
and nonworking days for your human resources, which accommodates varia-
tions such as 4-day weeks or shift work.

You can set different rates for resources, such as a standard hourly rate and an
overtime rate. Project applies the appropriate rate based on each resource’s cal-
endar and work assigned. For more about resources and costs, see Chapter 7.

Several views in Project let you see information about resources and how
their assignment to tasks has an effect on project costs. Figure 1-4 shows you
the Resource sheet which has columns of information about resources and
their costs.

Here’s one other important thing you should know about resources: They
tend to have conflicts. No, I'm not talking about conference room brawls
(although that happens). These conflicts have to do with assigned resources
that become overallocated for their available work time. For example, if you
assign one poor soul to three 8-hour tasks that must all happen on the same
day — and in the same eight hours — Project has features that do everything
but jump up on your desk and turn on an alarm to warn you of the conflict.
(Luckily, Project also provides tools that help you resolve those conflicts.)
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Spreading the news

I'm one of those people who need instant gratification. One of the first things
[ ask about learning to use any new software product is, “What’s in it for me?”
Until now, I've told you about the type of information you have to put into
Project: information about tasks, task dependencies, and resources. But isn’t
it about time you got something back from Project? Of course it is.

You finally reached one of the big payoffs for entering all that information:
reporting. After you enter your information, Project offers a wealth of report-
ing options to help you view your project and communicate your progress to
your project team, clients, and management.

You can generate predesigned reports based on information in your schedule
or simply print any of the views you can display in Project. Project 2007 offers
a set of Basic Reports and Visual Reports. (You must have the Microsoft .NET
Framework installed in order to use Visual Reports, which is free and down-
loadable from www.microsoft.com/downloads.) Figures 1-5 and 1-6 show
you just two of the reporting options available in Project.
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Planning to keep things on track

Projects aren’t frozen in amber like some organizational mosquito: They go
through more changes than a politician’s platform in a campaign year. That’s
where Project’s capability to make changes to your project data comes in
handy.

After you build all your tasks, give them durations and dependencies, and
assign all your resources and costs, you set a baseline. A baseline is a snap-
shot of your project at the moment you feel your plan is final and you're
ready to proceed with the project. After you set a baseline, you record some
activity on your tasks. Then you can compare that actual activity with your
baseline because Project saves both sets of data in your schedule.

Tracking activity in your project involves recording the actual timing of tasks
and recording the time that your resources have spent on those tasks, as well
as entering any actual costs that accrue. You can then display Project views
that show you how far off you are at any time (compared with your baseline)
in terms of the actual timing of tasks and cost of your project.

17
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Whether you have good news or bad, you can use reports to show your boss
how things are going compared with how you thought they would go. Then,
after you peel your boss off the ceiling, you can use many more Project tools
to make adjustments to get everything back on track.

The Role of the Project Manager
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Although understanding the role (let alone the usefulness) of some managers
isn’t always easy, it’s always easy to spot the value of a project manager. This
person creates the master plan for a project and tries to ensure that it gets
implemented successfully. Along the way, this key person uses skills and
methods that have evolved over time, always seeking to manage how things
get done and generally keeping schedules on track.

What exactly does a project manager do?

A project manager isn’t always the highest authority in a project; often that
role belongs to whomever manages the project manager, up to and including
members of senior management. Rather, the project manager is the person
on the front lines who makes sure that the parts of the project come together
and assumes hands-on responsibility for successes as well as failures.

In project management parlance, the person who champions (and has the
ultimate responsibility for) a project is the project sponsor.

A project manager manages these essential pieces of a project:

v The project plan or schedule: This is what you create with Microsoft
Project. It includes the estimated steps and associated timing and costs
involved in reaching the project goal.

1 Resources: Managing resources involves resolving resource conflicts
and building consensus as well as assigning resources and tracking their
activities on the project. This part of the job also involves managing
nonhuman resources, such as materials and equipment.

1 Communication with the project team, management, and customers:
Communicating the project’s status to everyone who has a legitimate
stake in its success (stakeholders) is a key responsibility.

Although a project manager might work for a project sponsor, the project
often also has a customer for whom the end product is produced. That cus-
tomer can be outside the project manager’s own company, or within.
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Understanding the dreaded
triple constraint

You've seen the signs at the copy store or the auto repair place: You can have
it fast, cheap, or right; pick two. That, my friend, is the triple constraint of
project management in a nutshell.

In a project, you have timing, resources (which are essentially costs), and
quality of the product or service produced at the end of the project. Microsoft
Project helps you manage the resources and timing of your project. The qual-
ity of your project is often affected directly by how well you manage them. If
you add time, costs increase because resources are working longer hours at a
certain wage. If you take away resources, you save money, but this can affect
quality — and so on.

Coming to a logical balance of time, money, and quality is at the core of what
a good project manager does throughout the life of a project.

Applying tried-and-true methodologies

Microsoft Project incorporates some scheduling and tracking tools that are
the result of many years of developing project management methods. A few
of these are worth noting:

v The Gantt Chart (shown in Gantt Chart view of Figure 1-7), which is
the main view of Project, shows you a spreadsheet with columns of
data along with a graphical representation of the tasks in the project
arranged along a horizontal timeline. By using the data in the columns
(such as task name, start date, finish date, and resources assigned to
tasks), you can understand the parameters of each task and see its
timing in the graphical area. Being able to view all this information on
one page helps you understand what’s happening in your project in
terms of time and costs.

v The Network Diagram (also called a logic diagram), shown in Figure
1-8, is essentially the Microsoft version of a PERT chart. PERT (Program
Evaluation and Review Technique) was developed during the construc-
tion of the Polaris submarine in the 1950s. This mostly graphical repre-
sentation of the tasks in your project reflects the flow of work in your
project rather than the literal timing of tasks. This view helps you to see
how one task flows into another and to get a sense of where you are —
not so much in time, but rather in terms of the work you have to
accomplish.
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Risk management is a central part of project management because,
frankly, projects are chock-full of risk. You run the risk that your
resources won’t perform, that materials will arrive late, that your cus-
tomer will change all the parameters of the project halfway through —
well, you get the picture.

Risk management is the art of anticipating risks, ranking them from most
to least likely, and determining strategies to prevent the most likely ones
from occurring. Project helps you with risk management by allowing you
to try out what-if scenarios: You can change the start date or length of

a task or phase of tasks (for example) and see just what that change
does to your schedule, such as the delays, cost overruns, and resource
conflicts that might occur in such a scenario, down to the last hour and
penny. Having this kind of information at your fingertips makes risk man-
agement easier and (almost) painless.

Resource management consists of using resources wisely. A good pro-
ject manager finds the right resource for the job, assigns that person a
reasonable workload, stays alert for shifts in the schedule that cause
that resource to be overbooked, and during the life of the project makes
adjustments that keep all resources most productive. In Project, tools
are available, such as a resource graph (traditionally called a histogram)
and the resource usage chart (shown in Figure 1-9), which reflects
resource workload.
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Figure 1-9 also shows resource leveling (a calculation that automatically
reschedules resources to resolve overbooking), which can enable you to
manage resources much more effectively. You can see how overbooked
the Information Systems Analyst is on this date.

You can use codes for resources that designate skill levels or abilities so that
finding the right resource for each job is as simple as performing a search.

From To-Do List to Hard Drive

If you're reading from start to finish in this chapter, you're probably shaking
your head and saying, “Boy, handwritten to-do lists look pretty good right
now. Beats creating hundreds of tasks, assigning them durations, establishing
dependencies among them, creating resources, entering resource calendar
and rate information, assigning resources and costs to tasks, entering activity
performed on tasks . ..” and so on.

Well, you're right and wrong about that. You do have to enter a lot of informa-
tion into Project to get the benefit of its features. But you can also get a lot
out of Project.

Getting up to speed with Project

Take a moment to look at some of the wonderful things Project can do for
you. This list describes why you (or your company) bought it and why you're
investing your time to read this book.

With Project, you enjoy the following benefits:

v Project automatically calculates costs and timing for you based on your
input. You can quickly recalculate what-if scenarios to solve resource
conflicts, get your costs within budget, or meet your final deadline.

v Project offers views and reports that, with the click of a button, make a
wealth of information available to you and those you report to. No more
manually building a report on total-costs-to-date to meet a last-minute
request from your boss. If she wants to know total-costs-to-date, you can
just print your Tracking Gantt view with the Tracking table displayed.
See Chapter 16 for information about reporting.

» You can use built-in templates to get a head start on your project. Project
templates are prebuilt plans for a typical business project, such as com-
mercial construction, an engineering project, a new product rollout,
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software development, or an office move. See “Starting with templates”

W later in this chapter for more about this time-saving feature.

You likely do similar types of projects all the time. After you create one
project, you use it as a template for future projects.

» You can create resources for your project according to information you
already created in your Outlook Address Book. You can even create one
set of company resources and give access to every project manager in
the company (see Chapters 18 and 19 for how to set up centralized
enterprise resources).

v A number of tools in Project employ complex algorithms (that you couldn’t
even begin to figure out) to do such tasks as level resource assignments to
solve resource conflicts, filter tasks by various criteria, model what-if sce-
narios, and calculate in dollars the value of work performed to date.

Collaborating with your
project team online

You can take advantage of all the Internet has to offer by using Project fea-
tures to collaborate with others. In fact, Project 2007 begins to step into the
world of Enterprise Project Management (EPM), where easily sharing ideas,
information, and documents across your enterprise becomes possible.

For example, Project allows you to request updates on a task’s progress from
team members via e-mail. You can post documents and ask for team input.
You can even publish your project on the Web.

The Professional version of Project includes Project Server and Project Web
Access, which enhance workgroup collaboration. You can take advantage of
an online project center and resource center with areas for discussions,
progress tracking, document exchange, and more.
< Part V of this book, “Working with Enterprise Projects,” looks at how to take
advantage of the enterprise-wide features of Project Server and Project Web
Access.

Getting Started

As Shakespeare said, “In delay there lies no plenty.” I don’t know about you,
but I need all the plenty I can get, so it’s time to jump in and start using Project.



24

Part I: Setting the Stage for Project

You have three choices when starting a new project. You can use Project
Guide to get Project’s assistance creating a project, you can build a project
on your own from scratch by entering individual task and resource details, or
you can use a project template that already contains data related to your
industry or the type of project you're doing.

Getting going with help
from Project Guide

Project Guide is like some of those wizards you see in Microsoft products: It
walks you through a series of steps that ask you to enter some information
and then automates a process for you. However, in many ways, Project Guide
is like no wizard you've ever seen.

Taking a first look at the Guide

Project Guide has four different sections: Tasks, Resources, Track, and
Report. Within each of those categories might be ten or so links for you to
click to initiate an action. When you do so, you might have to choose a vari-
ety of subactions, depending on your particular project. Also, the sections of
Project Guide span the entire life of your project, from the time you first enter
task information to the time you generate your final report.

If you've never used project management software (or Project itself), you might
find it helpful to run through Project Guide to set up your first schedule, enter
resources, track activities on tasks, or generate reports. However, to know
how to make intelligent choices in Project Guide, you have to have some
basic understanding of how a project is built, which I provide in the next few
chapters. My advice is to walk with me through many of the steps in this
book and then use Project Guide to practice building your first project. Then
you can see whether its structure works the way your mind does — or not.

Using Project Guide

A Project Guide toolbar displays by default in the toolbar area at the top of
your Project screen. The toolbar has an icon you click to show or hide the
Project Guide, so if the Project Guide doesn’t appear on the left side of your
screen, just click the Show/Hide Project Guide button.

To use the Project Guide, you click a category (such as Tasks) and then click
a link (such as List the Tasks in the Project) in that category. This action dis-
plays additional information in the Project Guide pane (see Figure 1-10) asking
you to enter data or choose or accept a setting and move through a series of
screens. When you finish working through one set of screens, you return to
the Project Guide pane and can click another task or category to proceed.
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Guide, just click the categories and the tasks within them in sequence. They
should remind you of all the things you should consider, even if you choose to
skip a few steps here and there for your particular project.

Starting from scratch

Although you can use Project Guide to start a project, you don’t have to. You
can enter information on your own at any time.

When you open Project 2007, you see a blank project file on-screen along with
the Project Guide task pane. You can start building your new project directly

in this blank schedule. Starting to create a new project usually involves enter-
ing some general project information and then adding some task information.

You can open a new, blank project schedule at any time by choosing Files>
New and clicking the Blank Project link in the New Project task pane.
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P You need to enter much more information in addition to general project infor-
mation and tasks in order to build a complete project, as you discover in the
next few chapters. Entering general project information and task information
is your usual starting point, however.

Tell Project about your project

With a blank project open, a logical first step is to enter some general project
information, such as the project start date. To do so, you choose Project=
Project Information. The Project Information dialog box appears, as shown in

Figure 1-11.
Sart date: [Mon#fiiz ~ v]  Currentdater [Fril/13/06 El
Firish date: | Wied 425707 | stabusdater  [HA |
I | schedulafrom: | Proect Start Date | clendar: [Stendard |
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Project -

Custom Field Mame Value

Information
dialog box
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project

settings. e (e e

Here’s what you can do in this dialog box:

1 Set the start date for the project. If you're not sure when the project will
start, set the start date about a month from today. Then, after you build
some tasks and have a better handle on the entire length of your project,
you can come back and set a real start date. Project automatically recal-
culates all dates when you do.

1~ Set the finish date for the project. Especially if you have a drop-dead
date (an attention-getting term!) beyond which the project cannot
wander and still reach completion, you can set the finish date. In such a
case, be sure to look at the next setting in this list — and change it
accordingly.

v Schedule from the start or finish of the project. Most projects work for-
ward from the start date. However, if you have an absolute drop-dead
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date for the end of your project (for example, if you're organizing a
sports event that must occur on New Year’s Day next year), you might
want to set the finish date and then work backward to fit all your tasks
into the allotted length of time. If you change this setting to Project
Finish Date, the Finish Date field becomes available.

1 Set the current date. You can fill in the current date according to your
computer calendar. Or, you can choose another date if you like, but that
usually doesn’t make much sense unless you're in a different time zone
from where the project will occur.

1~ Set a status date. By default there is no status date set for the project.
You use a status date when you’re tracking the progress of your project
at regular intervals. If you set a status date, your computer assumes that
any activity you record in your project is being tracked as of this date.
You can find out more about this feature in Chapters 12, 13, and 14.

1 Set the working calendar for your project. You have three choices:
Standard, Night Shift, and 24 Hours. Base your choice on the working
habits of your organization. For example, if your company uses
resources in three shifts per day — a total of 24 hours of straight work-
ing time — and all those shifts would contribute work to your project,
choose 24 Hours. If you use a day shift and a night shift, choose Night
Shift. If you work a standard 8-hour day, choose Standard. (Most projects
use a standard calendar with a typical 8-hour workday.)

Calendars can get a little confusing. A project calendar that you set in
this dialog box indicates what the usual workday is like in your com-
pany, but you can set up individual calendars for each resource you
create. You can then more easily accommodate both shift workers and
nine-to-fivers in the same schedule. See Chapter 3 for more about
resource calendars.

1~ Assign a priority to your project. Assigning a priority (such as 500 for
high priority or 100 for a lower priority) can be especially useful if you
use the same resources across several projects. With your priorities set
on all projects, Project tools can then automatically reallocate
resources.

You can also create custom project information fields for your organization in
the Enterprise Custom Fields section of this dialog box. For example, you
might want a field that explains which department in the company is running
the project.

Clicking the Statistics button in this dialog box presents an overview of your
project, as shown in Figure 1-12.
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Perusing the project schedule

After you choose settings in the Project Information dialog box and then click
OK, you’re faced with a blank Project schedule, as shown in Figure 1-13. As a
writer, [ can tell you that nothing is as daunting — or as inspiring — as facing
a blank page. It’s the canvas on which you create your Project plan. Note the
Project Guide pane to the left of the spreadsheet section.
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In Figure 1-13 you see Gantt Chart view. You can discover more about various
views in Chapter 2. For now, note the following:

v View bar: To go to different views, click the bar of icons on the far left:
the View bar. If this bar isn’t displayed, choose View=>View Bar to do so.

v Project Guide: To the right of the View bar is the Project Guide task
pane, which is an informational area with step-by-step guidance on how
to build your project. If Project Guide isn’t displayed, click the Show/
Hide Project Guide button on the Project Guide toolbar to display it.

+* Sheet: In the middle of the view is the sheet section. You can use this
spreadsheet interface to enter, edit, and view information about your
project.

v Chart area: Finally, the chart area on the far right reflects your task
information graphically as soon as you begin to add tasks.

e Taskbars in this area indicate the duration and timing of tasks in
addition to the progress you record on them.

¢ The timescale — the indications of time increments across the top
of the chart area — helps you interpret the timing of each taskbar.
You can adjust the increments to show your project in larger or
smaller increments of time. Figure 1-12, for example, shows incre-
ments in days.

You start building a project by entering tasks. Simply click a cell in the Task
Name column of the sheet section and then type the name. You can enter and
edit details of a task by entering information directly into various columns
(which you can display in many views) or by double-clicking the task name in
the sheet to access the Task Information dialog box (see Figure 1-14). I get
into more detail about entering task information in Chapter 2.
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Starting with templates

Reinventing the wheel has never been one of my favorite sports, so I'm grate-
ful that Microsoft provides some convenient project templates. These include
projects by type: for example, an engineering project or office move. Templates
already have many tasks appropriate to the task type created for you.

Figure 1-15 shows the Project Office template. Templates typically contain
sample tasks broken into logical phases, with task durations and dependencies
in place. The templates from Microsoft often include resources, but you can
create your own resources as well as use, edit, or delete the ones provided.

You can open a template from the New Project task pane. To do so, follow
these steps:

1. Choose Filec>New.

The New Project task pane appears, as shown in Figure 1-16.
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2. Click the On My Computer link.

The Templates dialog box opens. You can also use the On My Web Sites
and Templates on Office Online links to access online templates.

w

. Click the Project Templates tab, which is shown in Figure 1-17.

4. Click a template to display a preview.

(2]}

. When you find the template you want to use, click OK.

The template opens in Project document format (MPP). You can then
save the file with a new name. You can also delete tasks, move them
around, or add tasks as necessary for your project.

After opening a template, be sure to check its Project Information
(choose Project=>Project Information) to make sure that the Start Date
and Calendar options are set as you want.

If you modify a template and think that you might use that set of tasks again
for future projects, consider saving the file as a custom template. Just choose
File>Save As, and then select Template in the Save As Type list.
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Saving a Project for Posterity

Saving Project files works just as saving does in most other software you've
used. Here’s a reminder.

To save a Project file that you haven’t saved before, follow these steps:

1. Choose Filec>Save As.

2. Use the Save In list to locate the folder where you want to save the
file; then click to select it.

3. In the File Name text box, type a name for the project.

4. Click Save.
It’s good organizational practice to create a folder for your project where you
save in one place not only your Project files but also supporting documents,

e-mails, and other items. You can create a new folder from within the Save As
dialog box by clicking the Create New Folder button.

A\

Getting Help from Project

If you can get to work without mishap and turn on your computer, you proba-
bly know how to use a help system in software, too. Table 1-1 offers a rundown
of the type of help you can find in Project 2007 when you click the Help
button on the Standard toolbar.
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Table 1-1 Project Help Features
Help Option How to Use It
Microsoft Project Help This option displays the full Help feature with a

table of contents and a search field.

Show the Office Assistant Displays the annoying little icon that asks you to
enter your question in a natural-language style
(that is, a sentence) and offers topics to try to
address your questions.

Contents and Index Displays the same thing as Microsoft Project
Help. Go figure.

Reference Provides reference information such as a com-
prehensive list of all fields in Project, a glossary,
and a table of mouse and keyboard shortcuts.

Getting Started A side menu for this Help menu option offers a
tutorial and project map. The tutorial provides a
set of topics explaining Project from the basics
of what is project management through creat-
ing a plan. The project map is another take on
the phases involved in building your project.

Microsoft Office Online Because Project is part of the Office family of
products, this link is provided to the Office
online Assistance Center.

Microsoft Office Diagnostics This option automatically identifies errors and
tries to correct them. Use it if you have serious
problems using the software (for example, if the
software continually shuts down and gives you
error messages).

Project Guide The one option not accessed from the Help
menu, Project Guide is new in Version 12.
Project Guide, which appears when you open a
new project, offers links to step-by-step infor-
mation on how to build your project.

As you can see, you could spend a year just working your way through all the
help topics in Project. Don’t worry: They’re there when you need them, and
some, such as Project Guide, even pop up automatically to offer help.
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